
Mayura Draw
Mayura Draw is a powerful drawing program. Using Mayura Draw you can create illustrations composed
of graphical shapes such as rectangles, ellipses, polygons, bezier curves, and text. Mayura Draw has 
powerful tools for drawing, editing and transforming graphical objects. After you have drawn a few 
objects, you can select an object or a group of objects, and transform them. Objects can be edited even 
after transformation. To edit an object, select the object and drag any of the handles that become visible.

The following two sections describe the tools available on the tool bar on the left. To select a tool, click 
on the button representing the tool on the tool bar. Operations started using any tool can be canceled at 
any time by selecting another tool from the tool bar. Note that the shift key can be used to modify the 
operation of most tools.

How to draw
Line
Horizontal line
Vertical line
Rectangle
Square
Ellipse
Circle
Arc
Curve
Polygon
Text

After you have drawn an object, you can transform the object in a number of ways. You can transform an
object independently or you can select a group of objects to be transformed together. Mayura Draw 
treats text and graphics uniformly during transformation.

How to transform objects
Move
Scale
Rotate
Skew
Reflect

How to...
Include your drawing in Microsoft Word or other word processors
Change orientation to portrait or landscape mode
How to zoom in and zoom out
How to change color of lines, fills or text
Change line thickness, color or dash style
Change fill color or pattern
Draw arrow heads at line ends
Pick color, pattern and other attributes from one object and apply it to another
Group objects
Align and space objects

Miscellaneous
Interoperability with other applications
Send me your comments, bug reports, and request for new features



Shareware registration
NO WARRANTY

This Help file was written for Mayura Draw Version 3.0



How to draw a line

Select the line tool from the tool bar. Click the left mouse button where you want the line to start. Without
releasing the button, drag the mouse to the point where you want the line to end.

To constrain the line to a vertical or horizontal line, hold down the shift key while dragging the mouse.



How to draw a polygon

Select the polygon tool from the tool bar. Click the left mouse button where you want the first vertex of 
the polygon. Without releasing the button, drag the mouse to the point where you want the second 
vertex, then release the button. Click the left mouse button where you want the next vertex and release 
the button. Click and release the left mouse button where you want the next vertex, and the next, and so
on. When you come to the last vertex, double click the left mouse button.

To draw a closed polygon, double click on the first vertex, as the last vertex.



How to draw a rectangle

Select the rectangle tool from the tool bar. Click the left mouse button where you want the first corner of 
the rectangle. Without releasing the button, drag the mouse to the point where you want the opposite 
corner of the rectangle.

To constrain the rectangle to a square, hold down the shift key while dragging the mouse.



How to draw an ellipse

Select the ellipse tool from the tool bar. Click the left mouse button where you want the center of the 
ellipse. Without releasing the button, drag the mouse till the ellipse has the desired size and shape.

To constrain the ellipse to a circle, hold down the shift key while dragging the mouse.



How to draw an arc

Select the arc tool from the tool bar. Click the left mouse button where you want the center of the arc. 
Click the left mouse button where you want the arc’s starting angle. Without releasing the button, drag 
the mouse anticlockwise to the ending angle, while also moving away from the center till the arc has the 
desired radius.



How to draw a pie slice

Select the pie tool from the tool bar. Click the left mouse button where you want the center of the pie. 
Click the left mouse button where you want the pie slice’s starting angle. Without releasing the button, 
drag the mouse anticlockwise to the ending angle, while also moving away from the center till the pie 
slice has the desired radius.



How to draw a curve

Select the curve tool from the tool bar. Click the left mouse button where you want the first vertex of the 
curve. Without releasing the button, drag the mouse to the point where you want the second vertex, then
release the button. Click the left mouse button where you want the next vertex and release the button. 
Click and release the left mouse button where you want the next vertex, and the next, and so on. When 
you come to the last vertex, double click the left mouse button.

To draw a closed curve, double click on the first vertex, as the last vertex.

To create a corner vertex as opposed to a smooth vertex, hold down the shift key while creating the 
vertex.



Transforming means moving, scaling, rotating, skewing or reflecting objects.



How to draw text

Select the text tool from the tool bar. Click the left mouse button where you want the text to start. Without
releasing the button, drag the mouse to draw a rectangular text-frame, then release the button. Now 
start typing. When you reach the right edge of the text-frame the cursor will move to the next line 
automatically. The text-frame will automatically increase in height to accommodate the new line. If you 
resize the text-frame, text will reflow automatically. To resize the text-frame, select the selection tool from
the tool bar. Then select the text-frame and drag any of its handles. You only need to set the width of the
text-frame. Mayura Draw determines the height of the text-frame automatically.

To edit existing text, select the text tool from the tool bar and click the left mouse button on the baseline 
of the text you would like to edit. Use left and right arrow keys to position cursor. Use backspace key to 
delete characters.

To use a different font, select Font from the Text menu. Fonts are listed by their PostScript names.

To change line spacing select Leading from the Text menu. Leading is the distance from the base of one
line to the base of the next line. 

You can also left-align, center, right-align or justify text by selecting the appropriate alignment command 
from the Text menu. 

Mayura Draw supports PostScript fonts, under Windows 95 only, if you have installed Adobe Type 
Manager (ATM) software.



How to move objects

First, select the objects you would like to move. Click the left mouse button on the edge of (not inside) 
any one of the selected objects. Without releasing the button, drag the mouse until the objects have 
been moved to the desired position; then release the button.



How to scale objects

First, select the objects you would like to scale. Select the scale tool from the tool bar. Click the left 
mouse button on the origin, i.e., the point about which you would like to scale the objects. Move the 
mouse away from the origin. Click anywhere and without releasing the mouse button, drag the mouse 
until the objects have been scaled to the desired size.

To scale objects uniformly in horizontal and vertical directions, hold down the shift key while dragging the
mouse.



How to rotate objects

First, select the objects you would like to rotate. Select the rotate tool from the tool bar. Click the left 
mouse button on the origin, i.e., the point about which you would like to rotate the objects. Move the 
mouse away from the origin. Click anywhere and without releasing the button, drag the mouse until the 
objects have been rotated through the desired angle.

To rotate the objects in steps of 15 degrees, hold down the shift key while dragging the mouse.



How to skew objects

First, select the objects you would like to skew. Select the skew tool from the tool bar. Click the left 
mouse button on the origin, i.e., the point about which you would like to skew the objects. Move the 
mouse away from the origin. Click anywhere and without releasing the button, drag the mouse until the 
objects have been skewed to the desired shape.

To constrain the skewing to either horizontal or vertical direction, hold down the shift key while dragging 
the mouse.



How to reflect objects

First, select the objects you would like to reflect. Select the reflect tool from the tool bar. Click the left 
mouse button on the origin, i.e., the point about which you would like to reflect the objects. Move the 
mouse away from the origin. Click anywhere and without releasing the button, drag the mouse until the 
objects have been reflected about the desired line.



How to select objects

Select the selection tool from the tool bar. Click the left mouse button in an empty area near the objects 
you would like to select. Without releasing the button, drag the mouse until the selection marquee 
encloses the objects you would like to select. An object need not be enclosed entirely within the 
selection marquee in order to get selected. If a small portion of the object falls within the selection 
marquee, it will be included in the selection.

You can also toggle the selection status of an object, i.e., remove an object from the selection if it is 
already included in the selection, or add it to the selection if it is not already included. To toggle the 
selection status of an object, hold down the shift key while following the same steps as when you select 
an object.

To unselect all objects, click in an empty area on the page.



How to import your drawing into a word processor

Drawings created using Mayura Draw can be included in documents created using LaTeX, Microsoft 
Word, Corel WordPerfect, or other word processors. To import your drawing into a word processor, save 
your drawing in EPS format. Use the EPS inclusion capability of your word processor to include the 
drawing in a document.

To save your drawing in EPS format, choose Export from the File menu. Then change the Save file as 
type to EPS.

The EPS Options dialog will let you include a preview in the EPS file. If you are using a WYSIWYG word
processor such as Microsoft Word check the Include Preview option. Do not include a preview if you are 
using LaTeX. You can also embed fonts in the EPS file. By embedding fonts in the EPS file you can 
ensure that the text objects in the drawing will be printed using the right font even if the EPS file is 
transferred to another machine. However this will increase the size of the EPS file.

EPS files will only print at the intended quality if you have a PostScript printer. If your printer can’t 
understand PostScript, export to WMF format instead of EPS.

Technical information for advanced users: About the EPS file format

EPS is the format preferred by high-end desktop publishing systems. Unlike WMF and other formats, 
EPS uses PostScript, a powerful graphics language used by high-end typesetting machines costing tens
of thousands of dollars, such as Linotype, as well as cheaper laser printers costing under $1000, such 
as Hewlett Packard LaserJet 5MP.

EPS stands for Encapsulated PostScript. An Encapsulated PostScript file contains PostScript code 
designed to be included as a part of another page, rather than being sent to a PostScript printer directly. 
All EPS files contain PostScript code. However, PostScript code is in general only understood by 
printers equipped with a PostScript interpreter. Word processors do not understand PostScript code, and
therefore cannot directly display PostScript files on the screen. To solve this problem, EPS files may 
contain a preview bitmap in addition to the PostScript code. When you insert an EPS file into a word 
processor, your word processor ignores the PostScript code that it cannot understand, and instead 
depends on the preview bitmap to display the drawing on the screen. But when the word processor 
prints the document, it sends the PostScript code to the printer instead of the bitmap. This assumes your
printer can understand PostScript. If it cannot, the word processor sends the preview bitmap to the 
printer, resulting in poor quality.

Not all EPS files contain preview bitmaps. When you insert an EPS file which does not contain a preview
bitmap into a word processor, the word processor will not be able to display the drawing on the screen. 
Your word processor may instead display some details about the EPS file such as its name and the date
it was created. Even though the EPS file does not contain a preview bitmap, it still contains all the 
PostScript code necessary to print the picture. So when you print the document, the word processor 
sends the PostScript code to the printer and the drawing will appear in the output. Again, this assumes 
that your printer is a PostScript printer. If it is not, the word processor will not be able to print the graphic.

Do not confuse AI (Adobe Illustrator) format with EPS format. AI format is a simplified subset of EPS 
format. Since AI format is simpler many drawing programs can open AI files. However EPS files can be 
arbitrarily complex, so most programs can’t open EPS files unless, of course, your particular EPS file 
also happens to be an AI file. All AI files are EPS files* but not all EPS files are AI files.
*Note however, that AI format files often omit the PostScript header portion. If the header portion is missing in your AI file then it is 



not, strictly speaking, an EPS file. Use AI format only for interchanging a drawing among various drawing programs. When it is 
time to print, use EPS format because without a header, your AI file won’t print.

Trouble shooting

If your word processor is unable to print the EPS drawing you created using Mayura Draw, or if the 
output is of poor quality, check the following:
1. Does your printer support PostScript? If it does not, use WMF format instead of EPS.
2. Does your printer driver know that your printer supports PostScript? If your printer supports both PCL 
and PostScript you may be using a PCL printer driver. Install the PostScript printer driver that came with 
your printer.



Drawing programs and Painting programs

Drawing programs are vector-based. They let you modify objects such as circles, lines, rectangles etc. 
Drawing programs do not let you modify individual pixels. Mayura Draw is a drawing program.

Painting programs are bitmap-based. They let you modify individual pixels. However, painting programs 
do not let you modify objects such as rectangles, circles etc. An example of a painting program is 
Paintbrush.

Drawing programs print at the highest resolution supported by your printer. Output from painting 
programs look grainy.



How to change orientation to portrait or landscape mode

You can change the orientation of the page at any time to portrait or landscape mode and continue 
drawing. Select Orientation from View menu and choose the orientation you want to change to. Since 
orientation is only a view mode, you can switch from one orientation to another and back as many times 
as you want.

Note on printing landscape: It is not necessary to set the landscape mode in the Print setup dialog.



How to change fill style

To change the fill style of objects, first select    the objects which you want to change. Then choose the 
pattern or color you want from the Fill menu. The fill style you choose will remain in effect for the objects 
you draw later, until you change the fill style again.



How to change line style

To change the line style of objects, first select    the objects which you want to change. Then choose the 
dash style, line width or color you want from Line menu. Note that dashed lines can only be 1 point wide.
The line style you choose will remain in effect for the objects you draw later, until you change the line 
style again. 



How to change color of lines, fills or text 

Select the objects you want to change. Then choose Color from the Line menu to change line color, or 
Color from the Fill menu to change fill color. To change color of text objects choose Color from the Fill 
menu.

The color dialog
The color dialog lets you specify color in one of three different color models -- HSB, CMYK or RGB. HSB
is the most intuitive color model while CMYK is preferred by graphic artists. In the HSB color model, 
colors are specified using three parameters called Hue, Saturation and Brightness. Hue specifies the 
color of the color, such as blue or yellow. Saturation specifies the concentration of the selected hue with 
respect to the overall intensity. Less saturated color has some white light mixed in. If the saturation is set
to 0, you get a shade of gray. Brightness specifies the overall intensity of light. If the brightness is set to 
0, you get black.
In the color dialog, different hues are arranged around a color wheel. As you move towards the center of 
this wheel, saturation decreases. The dialog also has a brightness bar. As you move upwards on the 
brightness bar, the brightness increases.
To select a color, first select a hue by clicking at an appropriate angle on the color wheel. Now adjust the
saturation by moving towards or away from the center. Next click on the brightness bar. Move up or 
down to adjust the brightness. The currently chosen color is visible in the little square next to the 
brightness bar. Click OK to select the color.



How to pick color, pattern and other attributes from one object and apply it to another

Select the object you would like to pick color, pattern, line style and other attributes from. Now click on 
the eye dropper button on the toolbar. The current paint style will be set to the paint style of the selected 
object. Next, select the objects you would like to apply the current paint style to. Then click on the brush 
button on the toolbar.



How to draw arrow heads at ends of lines

To draw arrow heads at ends of lines, first select the lines you are interested in. Then choose any of the 
last four items in the Line menu, depending on whether you want no arrow heads, arrow head on the 
first end, arrow head on the second end, or arrow heads on both ends. Three different arrow styles are 
available--Small, Big and Fancy. To change the arrow style, select the lines you are interested in. Then 
choose the style you want from the Arrows menu. To access the Arrows menu, click on Style menu and 
then click on Arrows.



Handles are little squares that become visible when you select an object. If the handles are white that 
means that the object is grouped and cannot be edited.



How to align and space objects

To align objects, select the objects you want to align. Then choose an appropriate command from the 
Align sub-menu in the Arrange menu.

Space Evenly in the Arrange menu rearranges selected objects such that the distance between them is 
uniform. The distance between objects can be either the distance between centers of the objects or the 
space between edges of the objects.



How to group objects

Select the objects you would like to group. Then choose Group from the Arrange menu. Group objects if 
you want a set of objects to behave as one object. If you select an object that is part of a group, the 
entire group will be selected. This ensures that you do not accidentally dismantle the group by moving or
editing one of the objects in the group. Note that grouped objects have white handles instead of black. 
White handles indicate that the selected object cannot be edited. If you want to edit an object that is part
of a group, you must Ungroup the objects first.

Text objects that are part of a group can be edited without ungrouping first.



Interoperability with other applications

Export your drawing in EPS or WMF formats to insert the drawing into your word processor. EPS format 
will give you the best possible results. However, your printer must support PostScript to take advantage 
of EPS. Use WMF format only if you don’t have a PostScript printer.

Drawings created using Mayura Draw can be opened in other drawing programs such as Adobe 
Illustrator 4.1, CorelDraw 6, Micrografx Windows Draw 4.0 and SmartSketch 95. First select Export from 
the File menu in Mayura Draw. In the Export dialog, change Save file as type to Adobe Illustrator. Enter 
a file name and click OK. Your drawing will be saved in Adobe Illustrator 88 format. This file can now be 
opened in any of the above programs.

To open a drawing created using any of the above programs in Mayura Draw, first start the application 
that created the drawing and export the drawing in Adobe Illustrator 88 format. Then in Mayura Draw 
choose Import from the File menu. Mayura Draw can import the AI format file you created.

Mayura Draw can also create PDF files. PDF stands for Portable Document Format. Using Adobe’s 
Acrobat Reader you can view and print PDF files, as well as publish them on the Internet. Acrobat 
Reader can be downloaded free of charge from www.adobe.com



How to zoom in and zoom out

Select the zoom tool from the toolbar. Click and drag a rectangle around the area you would like to zoom
in on. To zoom out, click anywhere and without moving the mouse, release the mouse button.



Mayura Software
Mayura Draw is Copyright (c) 1993-98 Mayura Software.

Mayura Draw is shareware. If you use Mayura Draw for more than 2 weeks you must register your copy 
of Mayura Draw by sending a shareware registration fee of $15 to:

Mayura Software
P.O. Box 50158
Palo Alto, CA 94303
USA

Permission is hereby granted to distribute unmodified copies of Mayura Draw. No charges are due to 
Mayura Software for distributing Mayura Draw.

Mayura Draw is distributed with NO WARRANTY of any kind. The author or distributors of this software 
do not accept responsibility for any damages arising from the use of this software.

Download latest version

To download the latest version of Mayura Draw visit:
http://www.mayura.com

How to send in your comments

You are invited to send me your questions, comments, any bugs you have found, or suggestions for the 
next version of Mayura Draw. Please e-mail your suggestions to:

info@mayura.com




